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Kit Contents 

Investigator DIPplex Kit (100) 

Catalog no. 384015 

Number of 25 μl reactions 100 

 Reaction Mix A 500 μl 

Primer Mix DIPplex 500 μl 

Multi Taq2 DNA polymerase 150 U 

Nuclease-free water 2 x 1.9 ml 

Control DNA 9948 200 μl 

DNA size standard 550 (BTO) 50 μl 

Allelic ladder DIPplex 25 μl 

Quick-Start Protocol 1 
 

Storage 
All components of the Investigator DIPplex Kit should be stored at –30 to –15°C. 
Avoid repeated thawing and freezing. Primer mix and allelic ladder must be 
stored protected from the light. DNA samples and post-PCR reagents (allelic 
ladder and DNA size standard) should be stored separately from the PCR 
reagents. Under these conditions, the components are stable until the expiration 
date indicated on the kit. 

Intended Use 
The Investigator DIPplex Kit is intended for molecular biology applications in 
human identity testing. This product is not intended for the diagnosis, 
prevention, or treatment of a disease. 

USA and Canada: not for use in, or in preparation for, legal proceedings, 
including parentage determination.  

All due care and attention should be exercised in the handling of the products. 
We recommend all users of QIAGEN® products to adhere to the NIH guidelines 
that have been developed for recombinant DNA experiments, or to other 
applicable guidelines. 
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Safety Information 
When working with chemicals, always wear a suitable lab coat, disposable 
gloves, and protective goggles. For more information, please consult the 
appropriate safety data sheets (SDSs). These are available online in convenient 
and compact PDF format at www.qiagen.com/safety where you can find, view, 
and print the SDS for each QIAGEN kit and kit component. 
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Introduction 
Human identification is commonly based on the analysis of short tandem 
repeats (STRs) or single nucleotide polymorphisms (SNPs), depending on the 
demands of an examination or on the sample quality. Analyzing biallelic 
deletion/insertion polymorphisms (DIPs) combines the advantages of both STR 
and SNP analysis. DIPs are particularly useful for identification in 
anthropological or population genetic applications. In addition, DIP analysis 
confers further benefits, such as the absence of stutter peaks, enabling mixed 
stain analysis. 

The Investigator DIPplex Kit was developed for multiplex amplification of 30 
biallelic DIPs plus Amelogenin. The 30 DIPs are distributed over 19 autosomes 
that are at least 10 Mbp away from any commercially available STR and SNP 
marker (Table 2, page 8). Therefore, in combination with standard markers, 
these DIP markers improve discriminatory power. 

The primers are fluorescence-labeled with one of the following dyes: 

 6-FAM™: Amelogenin, HLD77, HLD45, HLD131, HLD70, HLD6, HLD111, 
HLD58, HLD56 

 BTG: HLD118, HLD92, HLD93, HLD99, HLD88, HLD101, HLD67 

 BTY: HLD83, HLD114, HLD48, HLD124, HLD122, HLD125, HLD64, 
HLD81 

 BTR: HLD136, HLD133, HLD97, HLD40, HLD128, HLD39, HLD84 

We recommend using DIPSorter Freeware for easy sorting of genotypes and 
interpretation of results. 
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Table 1. Discrimination power of DIPs, STRs, and SNPs 

 Loci CPE/Trio* CPI† Population 

Investigator DIPplex 30 DIPs 
0.9980 2.83 x 10–13 

German 
Caucasian 

AmpFℓSTR® 
Minifiler™ 

8 STRs 0.99976 8.21 x 10–11 US Caucasian 

AmpFℓSTR SEfiler 
Plus™ 

11 STRs 0.999998 7.46 x 10–14 US Caucasian 

Powerplex® 16 15 STRs 0.9999994 5.46 x 10–18 US Caucasian 

Sanchez et al. 2006 
(1) 

52 SNPs 0.9998 5.00 x 10–21 
European 
Caucasian 

 

* Combined probability of paternity exclusion. 
† Combined probability of identity. 
 
The optimal amount of DNA under standard conditions is 0.2–0.5 ng. Internal 
validations demonstrated reliable results with <0.1 ng DNA. 

The Investigator DIPplex Kit was validated using the GeneAmp® PCR System 
9700 (with Gold-plated 96-Well Silver Block), ABI PRISM® 310, ABI PRISM 3100, 
Applied Biosystems 3130, and Applied Biosystems 3500 Genetic Analyzers. 

Table 2 (page 8) shows the DIP loci of the Investigator DIPplex, their 
chromosomal localization, GenBank®/SNP ID number, motif, and respective 
reference allele. 
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Table 2. Locus-specific information of the Investigator DIPplex Kit 

 
 
DIP locus 

 
Chromosome 
localization 

GenBank 
accession/ 
SNP ID 

 
 
Motif (+DIP) 

 
Reference 
allele 

DIPplex Blue     

Amelogenin X Xp22.1-22.3 M55418  X 

Amelogenin Y Yp11.2 M55419  Y 

HLD77 7q31.1 rs1611048 TAAG +DIP 

HLD45 2q31.1 rs2307959 CACG –DIP 

HLD131 7q36.2 rs1611001 TGGGCTTATT +DIP 

HLD70 6q16.1 rs2307652 AGCA –DIP 

HLD6 16q13 rs1610905 GCAGGACTGG 
GCACC 

–DIP 

HLD111 17p11.2 rs1305047 CACA –DIP 

HLD58 5q14.1 rs1610937 AGGA +DIP 

HLD56 4q25 rs2308292 TAAGT +DIP 

DIPplex Green     

HLD118 20p11.1 rs16438 CCCCA –DIP 

HLD92 11q22.2 rs201771066 GTTT –DIP 

HLD93 12q22 rs150042219 ACTTT –DIP 

HLD99 14q23.1 rs2308163 TGAT –DIP 

HLD88 9q22.32 rs8190570 CCACAAAGA +DIP 

HLD101 15q26.1 rs2307433 GTAG –DIP 

HLD67 5q33.2 rs1305056 CTACTGAC –DIP 
 

Table continued on next page; HLD: Human locus DIP; –DIP: Deletion; +DIP: Insertion. 
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Table continued from previous page. 

 
 
DIP locus 

 
Chromosome 
localization 

GenBank 
accession/ 
SNP ID 

 
 
Motif (+DIP) 

 
Reference 
allele 

DIPplex Yellow     

HLD83 8p22 rs2308072 AAGG –DIP 

HLD114 17p13.3 rs2307581 TCCTATTCTACT 
CTGAAT 

–DIP 

HLD48 2q11.2 rs28369942 GACTT –DIP 

HLD124 22q12.3 rs6481 GTGGA –DIP 

HLD122 21q22.11 rs8178524 GAAGTCTGAGG –DIP 

HLD125 22q11.23 rs16388 ATTGCC –DIP 

HLD64 5q12.3 rs397832668 GACAAA +DIP 

HLD81 7q21.3 rs17879936 GTAAGCATTGT –DIP 

DIPplex Red     

HLD136 22q13.1 rs16363 TGTTT –DIP 

HLD133 3p22.1 rs2067235 CAACCTGGATT  

HLD97 13q12.3 rs17238892 AGAGAAAGCTG 
AAG 

–DIP 

HLD40 1p32.3 rs146044344 GGGACAGGTGG 
CCACTAGGAGA 

+DIP 

HLD128 1q31.3 rs2307924 ATTAAATA –DIP 

HLD39 1p22.1 rs17878444 CCTAAACAAAAA 
TGGGAT 

–DIP 

HLD84 8q24.12 rs3081400 CTTTC –DIP 
 

HLD: Human locus DIP; –DIP: Deletion; +DIP: Insertion. 
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Equipment and Reagents to Be Supplied by User 
When working with chemicals, always wear a suitable lab coat, disposable 
gloves, and protective goggles. For more information, consult the appropriate 
safety data sheets (SDSs), available from the product supplier. 

 Hi-Di™ Formamide, 25 ml (Applied Biosystems®, cat. no. 4311320) 

 Matrix Standards BT5 for single-capillary instruments, e.g., ABI PRISM 310 
Genetic Analyzer (QIAGEN, cat. no. 386113) 

 Matrix Standards BT5 for multi-capillary instruments, e.g., ABI PRISM 3100 
and Applied Biosystems 3130 and 3500™ Genetic Analyzers (QIAGEN, 
cat. nos. 386123 or 386125) 

 Pipets and pipet tips 

 One of the following DNA analyzers: 
ABI PRISM 310 Genetic Analyzer 
ABI PRISM 3100-Avant™/3100 Genetic Analyzer 
ABI PRISM 3130/3130xl Genetic Analyzer  
Applied Biosystems 3500/3500xL Genetic Analyzer  

 One of the following PCR thermal cyclers:  
QIAGEN Rotor-Gene® Q 
GeneAmp PCR System 9700 
Bio-Rad PTC-200 
Techne TC-512 
Biometra T1 
Eppendorf® Mastercycler® ep 

 PCR tubes or plates 

Validity analysis software for human identification products 

Investigator Human Identification PCR Kits require calibration with an allelic 
ladder. Therefore, the software used must be compatible with human identification 
(HID) products for forensic applications. We recommend GeneMapper® ID, 
GeneMapper ID-X, or Genotyper® Software. The Investigator Template Files 
facilitate data analysis and are valid with the software mentioned above. 



 

Investigator DIPplex Handbook   11/2014 11 

Protocol: PCR Amplification 
This protocol is for PCR amplification of DIP loci from human DNA samples 
using the Investigator DIPplex Kit. 

Important points before starting 

 Set up all reaction mixtures in an area separate from that used for DNA 
isolation and PCR product analysis (post-PCR). 

 Use disposable tips containing hydrophobic filters to minimize cross-
contamination. 

Things to do before starting 

 Before opening the tubes with PCR components, vortex, and then centrifuge 
briefly to collect contents at the bottom of the tubes. 

Procedure 

1. Thaw PCR components and template nucleic acid. 
Mix thoroughly before use. 

2. Prepare a master mix according to Table 3, page 12. 
The master mix contains all of the components needed for PCR except the 
template (sample) DNA and nuclease-free water. 

Prepare a volume of master mix 10% greater than that required for the total 
number of PCR assays to be performed. This should include positive and 
negative control reactions.  

3. Mix the master mix thoroughly and dispense appropriate volumes 
into PCR tubes or the wells of a PCR plate. 

4. Add template DNA and nuclease-free water to the master mix, to 
give a final sample volume of 25 μl.  

5. Prepare positive and negative controls. 
Positive control: Use 5 μl of the Control DNA. 

Negative control: Use nuclease-free water instead of template DNA in the 
reaction.  
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Table 3. Reaction setup 

Component Volume per reaction 

Reaction Mix A* 5.0 μl 

Primer Mix 5.0 μl 

Multi Taq2 DNA Polymerase 0.6 μl 

Nuclease-free water (added in step 4) Variable 

Template DNA (added in step 4) Variable 

Total volume 25 μl 
 

* Contains dNTP mix, MgCl2, and bovine serum albumin (BSA). 
 

6. Program the thermal cycler according to the manufacturer’s 
instructions, using the conditions outlined in Table 4. 
For stains containing small amounts of DNA (<100 pg/25 μl reaction), we 
recommend using the cycling conditions outlined in Table 5 (page 13). 

Note: If using the GeneAmp PCR System 9700 with an Aluminum Block, 
use “Std Mode”, or with a Silver 96-Well Block or Gold-plated Silver 96-
Well Block, use “Max Mode”. Do not use “9600 Emulation Mode”. 

Table 4. Standard cycling protocol, recommended for all DNA samples  

Temperature Time Number of cycles 

94°C* 4 min – 

94°C 

61°C 

72°C 

30 s 

120 s 

75 s 

 

30 cycles 

68°C 60 min – 

10°C  – 
 

* Hot-start to activate DNA polymerase. 
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Table 5. Optional cycling protocol, recommended for stains containing 
small amounts (<100 pg) of DNA 

Temperature Time Number of cycles 

94°C* 4 min – 

94°C 

61°C 

72°C 

30 s 

120 s 

75 s 

 

32 cycles 

68°C 60 min – 

10°C  – 
 

* Hot-start to activate DNA polymerase. 
 

7. After the cycling protocol is completed, store samples at –30 to –15°C 
protected from the light, or proceed directly with electrophoresis. 
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Protocol: Electrophoresis Using the ABI PRISM 310 
Genetic Analyzer 
For general instructions on instrument setup, matrix generation, and application 
of the GeneScan® or GeneMapper ID Software, refer to the ABI PRISM 310 
Genetic Analyzer User’s Manual. Electrophoresis using the GeneScan Software 
is described below.  

The virtual filter set G5 is used for combined application of the 5 fluorescent 
labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is known as BT5.  

The materials required for electrophoresis are given in Table 6. 

Table 6. Materials required for electrophoresis 

Material Specifications 

Capillary 47 cm/50 μm (green) 

Polymer POP-4™ for ABI PRISM 310 Genetic Analyzer 

Buffer 10x Genetic Analyzer Buffer with EDTA 
 

Matrix generation 
Before conducting DNA fragment size analysis with the filter set G5, a matrix 
with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO must be 
generated (Table 7).  

Table 7. The fluorescent labels of BT5 

Color Matrix standard 

Blue (B) 6-FAM 

Green (G) BTG 

Yellow (Y) BTY 

Red (R) BTR 

Orange (O) BTO 
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1. Five electrophoresis runs should be conducted, one for each 
fluorescent label, under the same conditions as for the samples and 
allelic ladders of the Investigator DIPplex Kit, in order to generate 
suitable matrix files (Table 8).  

Table 8. Matrix setup for a single capillary instrument (ABI PRISM 310 
Genetic Analyzer) 

Matrix sample Component Volume 

Matrix sample 1 Hi-Di Formamide 

Matrix standard 6-FAM 

12 μl 

1 μl 

Matrix sample 2 Hi-Di Formamide 

Matrix standard BTG 

12 μl 

1 μl 

Matrix sample 3 Hi-Di Formamide 

Matrix standard BTY 

12 μl 

1 μl 

Matrix sample 4 Hi-Di Formamide 

Matrix standard BTR 

12 μl 

1 μl 

Matrix sample 5 Hi-Di Formamide 

Matrix standard BTO 

12 μl 

1 μl 
 

 
2. Denature for 3 min at 95°C. 
3. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

4. Load the samples on the tray. 
5. Create a Sample Sheet and enter the sample designation. Table 9 

(page 16) shows the injection list for matrix generation. 
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Table 9. Injection list for matrix generation 

Parameter Settings 

Module File GS STR POP-4 (1 ml) G5 

Matrix File None 

Size Standard None* 

Injection Time (s) 5 

Injection Voltage (kV) 15 

Run Voltage (kV) 15 

Run Temperature (°C) 60 

Run Time (min) 24 
 

* Always prepare matrix standards without DNA Size Standard (BTO). 
 

Analysis of the matrix samples 

1. Run the GeneScan Software. 
2. Select “New” from the File menu, and then select “Project”.  
3. Open the folder of the current run and select “Add Sample Files”. 
4. Select a matrix sample in the “Sample File” column. 
5. Click “Sample” and then “Raw Data”. 
6. Check the matrix samples for a flat baseline. As shown in the figure 

(next page), there should be at least 5 peaks with peak heights of 
1000–4000 RFU for each matrix sample. 
Note: The optimal range is 2000–4000 RFU. 
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Electropherogram with raw data of the matrix standard 6-FAM. 

 

7. Select an analysis range with a flat baseline and re-inject the matrix 
sample, if necessary. 

8. Record start and end values (data points) of the analysis range; 
e.g., start value 3200, end value 5500. 

9. Calculate the difference between the end and start values; 
e.g., 5500–3200=2300 data points. 

Generation of a matrix 

1. Select “New” in the “File” menu, and then select “Matrix”. 
2. Import the matrix samples for all dyes (B, G, Y, R, and O). 
3. Enter a “Start At” value, e.g., 3200. 
4. Under “Points”, enter the calculated difference between end and 

start values, e.g., 2300. 
5. Click “OK” to calculate the new matrix. 

 

 
Matrix sample selection. 

 

▼ 3200 data points (X) 

             5500▼ 
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6. Select “Save as” in the File menu to save the new matrix in the 
matrix folder. 
 

 
New matrix BT5. 

 

Checking the matrix 

1. To check the new matrix with current samples, select “New” in the 
“File” menu, and then select “Project”. 

2. Open the folder of the respective run and select “Add Sample Files”. 
3. Select the sample(s) in the “Sample File” column. 
4. Click “Sample” and then “Install New Matrix” to open the matrix 

folder and select the new matrix. 
5. Re-analyze the samples. 

Note: There should be no pull-up peaks between the dye panels (B, G, Y, 
R, O) with the new matrix. 

 

Sample preparation 
1. Set up a mixture of formamide and DNA size standard according to 

Table 10. 

Table 10. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12.0 μl 

DNA Size Standard 550 (BTO) 0.5 μl 
 

 
2. For each sample to be analyzed, aliquot 12 μl of the mixture to a 

tube. 
3. Add 1 μl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
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5. Snap freeze by placing the plate on ice for 3 min. 
Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 

 

Setting up the GeneScan Software 
Create a Sample Sheet and enter sample designation (Table 11). 

Table 11. Injection list for ABI PRISM 310 Genetic Analyzer 

Component Settings 

Module File GS STR POP-4 (1 ml) G5 

Matrix File e.g., Matrix BT5 

Size Standard e.g., SST-BTO_60-260bp 

Injection Time (s) 5* 

Injection Voltage (kV) 15 

Run Voltage (kV) 15 

Run Temperature (°C) 60 

Run Time (min) 20† 
 

* Deviating from standard settings, the injection time may range between 1 and 10 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
up to 10 s may be necessary.  

† The run time for Investigator DIPplex was modified in order to be able to analyze fragments 
with lengths of up to 200 bp. 
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Analysis parameters 
Table 12 lists the recommended analysis parameters. 

Table 12. Recommended analysis parameters for the ABI PRISM 310 
Genetic Analyzer 

Parameter Settings 

Analysis Range Start: 2000 

Stop: 6000 

Data Processing Baseline: Checked 

Multi-component: Checked 

Smooth options: Light 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Size Call Range Min: 60 

Max: 550 

Size Calling Method Local Southern Method 

Split Peak Correction None 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be 
detected by the GeneScan or GeneMapper ID Software. Thresholds are usually 50–200 RFU and 
should be determined individually by the laboratory. Recommendation: The minimal peak height 
should be 3 times as high as the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 

 

Note: For information on using the recommended Template Files (as analysis 
parameters), refer to the appropriate Investigator template files user guide 
(Genotyper, GeneMapper ID, or GeneMapper ID-X).  
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Protocol: Electrophoresis Using the ABI PRISM 3100-
Avant/3100 Genetic Analyzer 

For detailed instructions on instrument setup, spectral calibration, application of 
the ABI PRISM 3100 Data Collection Software version 1.01 or 1.1 and the 
GeneScan Software, refer to the ABI PRISM 3100-Avant/3100 Genetic Analyzer 
User’s Manual.  

The system with 4 capillaries is the ABI PRISM 3100-Avant Genetic Analyzer, 
and the system with 16 capillaries is the ABI PRISM 3100 Genetic Analyzer.  

The virtual filter set G5 is used for combined application of the 5 fluorescent 
labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is known as BT5.  

The materials required for electrophoresis are given in Table 13. 

Table 13. Materials required for electrophoresis 

Material Specifications 

Capillary 36 cm Capillary Array for ABI PRISM 3100-Avant/3100 
Genetic Analyzer 

Polymer POP-4 Polymer for ABI PRISM 3100-Avant/3100 
Genetic Analyzer 

Buffer 10x Genetic Analyzer Buffer with EDTA 
 

Spectral calibration/matrix generation 
Proper spectral calibration is critical for evaluation of multicolor systems with 
the ABI PRISM 3100-Avant/3100 Genetic Analyzer and should be done before 
conducting fragment length analysis. The calibration procedure creates a 
matrix which is used to correct the overlapping of fluorescence emission 
spectra of the dyes.  

Spectral calibration comprises the following steps: 

 Preparation of the spectral calibration standards 

 Loading the standards to the 96-well reaction plate (one sample per 
capillary) 

 Entering the plate composition 

 Performing a spectral calibration run and checking the matrix 
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Preparing the spectral calibration standards 

Example for 4 capillaries (ABI PRISM 3100-Avant Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 14. 

Table 14. Setup of formamide and Matrix Standard BT5 mixture for 
4 capillaries 

Component Volume 

Hi-Di Formamide 60 μl 

Matrix Standard BT5 multi cap. 5 μl 
 

 
2. Load 12 μl of the mixture to a 96-well plate; e.g., positions A1–D1. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Example for 16 capillaries (ABI PRISM 3100 Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 15. 

Table 15. Setup of formamide and Matrix Standard BT5 mixture for 
16 capillaries 

Component Volume 

Hi-Di Formamide 204 μl 

Matrix Standard BT5 multi cap. 17 μl 
 

 
2. Load 12 μl of the mixture to a 96-well plate; e.g., positions A1–H1 

and A2–H2. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 
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Performing a spectral calibration run 

The parameter file for Dye Set G5 must be modified once to achieve successful 
calibration with the Data Collection Software version 1.0.1 or 1.1. 

Spectral parameter 

1. To change settings in the parameter file, go to the following path: 
D:\AppliedBio\Support Files\Data Collection 
SupportFiles\CalibrationData\Spectral Calibration\ParamFiles 

2. Select “MtxSTD{Genescan_SetG5}” to open the PAR file. 
3. Change “Condition Bounds Range” to [1.0, 20.0]. 
4. If the calibration was unsuccessful, also change “Sensitivity” to 0.1 

and “Quality” to 0.8. 
5. Select “Save As” in the “File” menu and save the parameter file 

under a new name; e.g., MtxStd{Genescan_SetG5_BT5}.par. 
Note: Always use this parameter file for spectral calibration runs using 
QIAGEN Matrix Standard BT5. 

Plate Editor for spectral calibration 

1. Place the 96-well plate on the autosampler tray. 
2. Run the ABI PRISM 3100 Data Collection Software. 
3. In Plate View, click “New” to open the Plate Editor dialog box. 
4. Enter a name for the plate. 
5. Select a Spectral Calibration. 
6. Select “96-Well” as plate type, and click “Finish”. 

Table 16. Plate Editor for spectral calibration 

Parameter Settings 

Sample Name Enter name for the matrix samples 

Dye Set G5 

Spectral Run Module Default (e.g., Spect36_POP4) 

Spectral Parameters MtxStd{GeneScan_SetG5_BT5}.par 
(parameters created before) 

 

 
7. Click the column header to select the entire column, and select “Fill 

Down” from the “Edit” menu to apply the information to the selected 
samples. Confirm by clicking “OK”. 
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8. Link the reaction plate on the autosampler tray with the created 
plate ID and start the run. 

9. Upon completion of the run, check the Spectral Calibration Result 
dialog box to show that all capillaries have successfully passed 
calibration (label A).  
If individual capillaries are labeled X, refer to the ABI PRISM 3100-
Avant/3100 Genetic Analyzer User’s Manual. 

10. Click “OK” to confirm completion of the run. 

Checking the matrix 

1. Select “Display Spectral Calibration” from the “Tools” menu, then 
“Dye Set”, and “G5” to review the spectral calibration profile for 
each capillary. 

2. The quality value (Q value) must be greater than 0.95 and the 
condition number (C value) must be between 1 and 20. Both values 
must be within the predetermined range. 

3. Check for a flat baseline in the matrix samples. There should be 5 
peaks with heights of 1000–5000 RFU in each matrix sample. 
Note: The optimal range is 2000–4000 RFU. 

4. Check the new matrix with the current samples. There should be no 
pull-up peaks between the dye panels (B, G, Y, R, and O) with the 
new matrix. 

5. If the calibration failed, follow instructions in the section “Spectral 
parameter” on page 23. 

6. If all capillaries have passed the calibration, the last calibration file 
for Dye Set G5 must be activated manually. Go to “Tools” and click 
“Set Active Spectral Calibration”. 

7. Rename the calibration file under “Set Matrix Name” (e.g., BT5_Date 
of calibration). 

Sample preparation 
1. Set up a mixture of formamide and DNA size standard according to 

Table 17. 

Table 17. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12 μl 

DNA Size Standard 550 (BTO) 0.5 μl 
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2. For each sample to be analyzed, aliquot 12 μl of the mixture to a 
tube. 

3. Add 1 μl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
5. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 
 
Since injections take place simultaneously on all capillaries, 4 or 16 samples 
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples 
are analyzed, the empty positions must be filled with 12 μl Hi-Di Formamide. 

To ensure reliable allelic assignment on multi-capillary analyzers, several 
ladders should be run. 

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur, especially at 
low temperatures. Ensure ambient conditions are kept as recommended by the 
instrument manufacturer. 

Setting up the GeneScan Software 
1. Edit the default run module in Dye Set G5 once for the first run. 

Select “Module Editor” to open the dialog box. 
2. Select the appropriate Run Module as template from the GeneScan 

table (see Table 18 on page 26). 
3. Modify the Injection Voltage to 3 kV and the Injection Time to 10 s. 
4. Click “Save As” and enter the name of the new module (e.g., 

3kV_10s_260bp). Confirm by clicking “OK”. 
5. Click “Close” to exit the Run Module Editor. 
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Table 18. Run Module 3kV_10s_260bp for the ABI PRISM 3100-
Avant/3100 Genetic Analyzer 

Parameter Setting 

Run Temperature (°C) Default 

Cap Fill Volume Default 

Maximum Current (A) Default 

Current Tolerance (A) Default 

Run Current (A) Default 

Voltage Tolerance (kV) Default 

Pre-Run Voltage (kV) Default 

Pre-Run Time (s) Default 

Injection Voltage (kV) 3.0 

Injection Time (s) 10* 

Run Voltage (kV) Default 

Number of Steps Default 

Voltage Step Interval Default 

Data Delay Time (s) Default 

Run Time (min) 15† 
 

* Deviating from the standard settings, the injection time may range between 1 and 20 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
of up to 20 s may be necessary.  

† The run time for Investigator DIPplex was modified in order to be able to analyze fragments 
with lengths of up to 200 bp. 

Starting the run 

1. Place the prepared 96-well plate on the autosampler tray. 
2. Run the ABI PRISM 3100 Data Collection Software. 
3. In “Plate View”, click “New” to open the Plate Editor dialog box. 
4. Enter a name for the plate. 
5. Select “GeneScan” as the application type. 
6. Select “96-Well” as plate type, and click “Finish”. 
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Table 19. Settings in Plate Editor 

Parameter Settings 

Sample Name Enter name for the matrix samples 

Dyes O 

Color Info Ladder or sample 

Project Name e.g., 3100_Project1 

Dye Set G5 

Run Module 3kV_10s_260bp* 

Analysis Module 1 DefaultAnalysis.gsp 
 

* See Table 18, “Run Module 3kV_10s_260bp for the ABI PRISM 3100-Avant/3100 Genetic 
Analyzer”. 
 
7. Complete the table in the “Plate Editor” and click “OK”. 
8. Click the column header to highlight the entire column and select 

“Fill Down” from the “Edit” menu to apply the information to the 
selected samples. 

9. Link the reaction plate on the autosampler tray to the created plate 
ID and start the run. 

10. Upon completion of the run, view the data as Color Data in the 
Array View of the 3100 Data Collection Software or as Analyzed 
Sample Files under D:/AppliedBio/3100/DataExtractor/ExtractRuns. 
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Analysis parameters 
Table 20 lists the recommended analysis parameters. 

Table 20. Recommended analysis parameters for the ABI PRISM 3100-
Avant/3100 Genetic Analyzer 

Parameter Settings 

Analysis Range Start: 2000 

Stop: 6000 

Data Processing Baseline: Checked 

Multi-component: Checked 

Smooth options: Light 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Size Call Range Min: 60 

Max: 550 

Size Calling Method Local Southern Method 

Split Peak Correction None 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be 
detected by the GeneScan or GeneMapper ID Software. Thresholds are usually 50–200 RFU and 
should be determined individually by the laboratory. Recommendation: The minimal peak height 
should be 3 times higher than the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 

 
Note: For information on using the recommended Template Files (as analysis 
parameters), refer to the appropriate Investigator template files user guide 
(Genotyper, GeneMapper ID, or GeneMapper ID-X). 
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Protocol: Electrophoresis Using the Applied 
Biosystems 3130/3130xl Genetic Analyzer 
For detailed instructions on instrument setup, spectral calibration, or application 
of the ABI PRISM Data Collection Software version 3.0 and the GeneMapper ID 
Software, refer to the Applied Biosystems 3130/3130xl Genetic Analyzers 
Getting Started Guide.  

The system with 4 capillaries is the Applied Biosystems 3130 Genetic Analyzer, 
and the system with 16 capillaries is the Applied Biosystems 3130xl Genetic 
Analyzer. 

The virtual filter set Any5Dye is used for combined application of the 5 
fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is 
known as BT5.  

The materials required for electrophoresis are given in Table 21. 

Table 21. Materials needed for electrophoresis 

Material Specifications 

Capillary 36 cm Capillary Array for Applied Biosystems 
3130/3130xl Genetic Analyzer 

Polymer POP-4 Polymer for Applied Biosystems 3130/3130xl 
Genetic Analyzer 

Buffer 10x Genetic Analyzer Buffer with EDTA 
 

Spectral calibration/matrix generation 
Before conducting DNA fragment size analysis, it is necessary to perform a 
spectral calibration with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and 
BTO for each analyzer. The calibration procedure creates a matrix which is 
used to correct the overlapping of fluorescence emission spectra of the dyes.  

Spectral calibration is comprised of the following steps: 

 Preparation of the spectral calibration standards 

 Loading the standards to the 96-well reaction plate (one sample per 
capillary) 

 Creating the instrument protocol for spectral calibration (Protocol Manager) 

 Defining the plate composition in the plate editor (Plate Manager) 

 Performing a spectral calibration run and checking the matrix 
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Preparing the spectral calibration standards 

Example for 4 capillaries (Applied Biosystems 3130 Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 22. 

Table 22. Setup of formamide and Matrix Standard BT5 mixture for 
4 capillaries 

Component Volume 

Hi-Di Formamide 60 μl 

Matrix Standard BT5 multi cap. 5 μl 
 

 
2. Load 12 μl of the mixture to a 96-well plate, e.g., positions A1–D1. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Example for 16 capillaries (Applied Biosystems 3130xl Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 23. 

Table 23. Setup of formamide and Matrix Standard BT5 mixture for 
16 capillaries 

Component Volume 

Hi-Di Formamide 204 μl 

Matrix Standard BT5 multi cap. 17 μl 
 

 
2. Load 12 μl of the mixture to a 96-well plate, e.g., positions A1–H1 

and A2–H2. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 
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Performing spectral calibration run 
1. Place the 96-well plate on the autosampler tray. 
2. In the Protocol Manager of the Data Collection Software, open the 

“Instrument Protocol” window. 
3. Click “New” to open the “Protocol Editor” dialog box. 
4. Complete the dialog box with information from Table 24 and click 

“OK”. 

Table 24. Instrument protocol for spectral calibration 

Protocol Editor Settings 

Name User (e.g., Spectral36_POP4_BT5) 

Type SPECTRAL 

Dye Set Any5Dye 

Polymer User (e.g., POP-4)* 

Array Length User (e.g., 36 cm)* 

Chemistry Matrix Standard 

Run Module Default (e.g., Spect36_POP4_1)* 
 

* Depends on the type of polymer and length of capillary used. 
 
5. Click “New” in the Plate Manager of the Data Collection Software to 

open the “New Plate” dialog box. 
6. Enter information from Table 25 and click “OK”. A new table in the 

Plate Editor opens automatically (Table 26). 

Table 25. Plate Editor for spectral calibration (I) 

New plate dialog Settings 

Name e.g., Spectral_BT5_date 

Application Spectral Calibration 

Plate Type 96-well 

Owner Name/ 
Operator Name 

… 
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 Table 26. Plate Editor for spectral calibration (II) 

Parameter Settings 

Sample Name Enter name for the matrix samples 

Priority e.g., 100 

Instrument Protocol 1 Spectral36_POP4_BT5 (setting described before) 
 

 
7. Click the column header to select the entire column, and select “Fill 

Down” from the “Edit” menu to apply the information to the selected 
samples. Confirm by clicking “OK”. 

8. Link the reaction plate on the autosampler tray with the created 
plate ID (position A or B) and start the run. 

 

 
Electropherogram of spectral calibration with matrix standard BT5 on an Applied 
Biosystems 3130 Genetic Analyzer. 
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Checking the matrix 

1. The quality value (Q value) of each capillary must be greater than 
0.95 and the condition number range (C value) must be between 1 
and 20. 

2. Check for a flat baseline in the matrix samples. As shown in the 
figure on the previous page, there should be 5 peaks with peak 
heights of about 1000–5000 RFU in each matrix sample. 
Note: The optimal range is 2000–4000 RFU. 

3. Check the new matrix with the current samples. There should be no 
pull-up peaks between the dye panels (B, G, Y, R, O) with the new 
matrix. 

4. If calibration failed, use the optimized values of the Matrix Standard 
BT5 and repeat the calibration run. 

5. If all capillaries have passed the test, the last calibration file for the 
Dye Set Any5Dye is activated automatically in the Spectral Viewer. 
Rename the calibration file (e.g., BT5_Date of calibration). 

 

Sample preparation 
1. Set up a mixture of formamide and DNA size standard according to 

Table 27. 

Table 27. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12.0 μl 

DNA Size Standard 550 (BTO) 0.5 μl 
 

 
2. For each sample to be analyzed, aliquot 12 μl of the mixture to a 

tube. 
3. Add 1 μl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
5. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 
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Since injections take place simultaneously on all capillaries, 4 or 16 samples 
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples 
are analyzed, the empty positions must be filled with 12 μl Hi-Di Formamide. 

To ensure reliable allelic assignment on multi-capillary analyzers, several 
ladders should be run. 

Room temperature may influence the performance of PCR products on multi- 
capillary instruments, so that shoulder peaks or split peaks occur especially at 
low temperatures. Ensure ambient conditions are kept, as recommended by the 
instrument manufacturer. 

Setting up the Data Collection Software 
1. Edit the Run Module once for the first run. In the Module Manager of 

the Data Collection Software, click “New” to open the “Run Module 
Editor” dialog box.  
Note: Modify the Run Module Default settings from 
“HIDFragmentAnalysis36_POP4_1” to those shown in Table 28 

2. Modify the Injection Voltage to 3 kV and the Injection Time to 10 s 
(Table 28). 

3. Click “Save As”, enter a name for the new Run Module  
(e.g., 3kV_10s_260bp), and confirm by clicking “OK”. 

4. Click “Close” to exit the Run Module Editor. 
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Table 28. Run Module 3kV_10s_260bp for the Applied Biosystems 
3130/3130xl Genetic Analyzer 

Parameter Settings 

Oven Temperature (°C) Default 

Poly Fill Volume Default 

Current Stability (μA) Default 

Pre-Run Voltage (kV) Default 

Pre-Run Time (s) Default 

Injection Voltage (kV) 3.0 

Injection Time (s) 10* 

Voltage Number of Steps Default 

Voltage Step Interval Default 

Data Delay Time (s) Default 

Run Voltage (kV) Default 

Run Time (s) 900† 
 

* Deviating from the standard settings, the injection time may range between 1 and 20 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
of up to 20 s may be necessary.  

† Depending on the analysis conditions the run time for Investigator DIPplex was modified in 
order to be able to analyze fragments with lengths of up to 200 bp. 

Starting the run 

1. Place the prepared 96-well plate on the autosampler tray. 
2. Open the Protocol Manager of the Data Collection Software. 
3. Click “New” in the Instrument Protocol window to open the “Protocol 

Editor” dialog box and enter the information in Table 29. 
4. Click “OK” to exit the Protocol Editor. 
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Table 29. Settings in Instrument Protocol 

Protocol Editor Settings 

Name Run36_POP4_BT5_15min 

Type REGULAR 

Run Module 3kV_10s_260bp* 

Dye Set Any5Dye 
 

* See Table 28, “Run Module 3kV_10s_260bp for the Applied Biosystems 3130/3130xl 
Genetic Analyzer”. 
 

5. Before each run, it is necessary to create a plate definition. In the 
Plate Manager of the Data Collection Software, click “New” to open 
the New Plate Dialog box. 

6. Enter the information in Table 30. 

Table 30. GeneMapper Plate Editor (I) 

Protocol Editor Settings 

Name e.g., Plate_BT5_Date 

Application Select GeneMapper Application 

Plate type 96-Well 

Owner Name/ 
Operator Name 

… 

 

 
7. Click “OK” and a new table in the Plate Editor opens automatically 

(Table 31). 
8. Click the column header to select the entire column. Select “Fill 

Down” from the “Edit” menu to apply the information to all selected 
samples. Click “OK”. 

9. In the Run Scheduler, click “Find All”, and select “Link” to link the 
reaction plate on the autosampler tray to the newly created plate 
record (position A or B). 
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Table 31. GeneMapper Plate Editor (II) 

Parameter Settings 

Sample Name Enter the name for the samples 

Priority e.g., 100 (Default) 

Sample Type Sample or Allelic Ladder 

Size Standard e.g., SST-BTO_60-260bp 

Panel e.g., DIPplex_Panels 

Analysis Method e.g., DIPplex_HID_3130_200rfu 

Snp Set – 

User-defined 1-3 – 

Results Group 1 (Select results group) 

Instrument Protocol 1 Run36_POP4_BT5_15min (setting described 
before) 

 

 
10. Start the run. 
11. During the run, view Error Status in the Event Log or examine the 

quality of the raw data for each capillary in the Capillaries Viewer or 
the Cap/Array Viewer. 

12. View data as an overview in Run History or Cap/Array Viewer of the 
Data Collection Software.  
Run data are saved in the Run Folder of the previously chosen Result Group. 
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Analysis parameters/analysis method 
Table 32 lists the recommended analysis parameters in the worksheet “Peak 
Detector”. Table 33 and Table 34 list the recommended settings for the 
worksheet “Allele” and “Peak Quality”. 

Table 32. Recommended settings for the Applied Biosystems 
3130/3130xl Genetic Analyzer 

Parameter Settings 

Peak Detection Algorithm Advanced 

Ranges Analysis: Partial Range 

Start Point: 2000; Stop Point: 6000 

Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  

Baseline Window: 51 pts 

Size Calling Method Local Southern Method 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Slope Thresholds: 0.0 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that 
will be detected by the GeneMapper ID Software. The thresholds are usually 50–200 RFU 
and should be determined individually by the laboratory. Recommendation: The minimal 
peak height should be 3 times higher than the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 
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Table 33. Recommended settings in the worksheet “Allele” 

Parameter Settings 

Amelogenin Cutoff 0.1* 
 

* As with Amelogenin, all DIPs will be examined using GeneMapper ID Software. 

Table 34. Recommended settings in the worksheet “Peak Quality” 

Parameter Settings 

Heterozygote Balance (Minimum peak height ratio) 0.1 

Allele Number (Maximum expected alleles) 20 
 

 

Note: For information on using the recommended Template Files (as analysis 
parameters), refer to the appropriate Investigator Template files user guide 
(Genotyper, GeneMapper ID, or GeneMapper ID-X). 
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Protocol: Electrophoresis Using the Applied 
Biosystems 3500/3500xL Genetic Analyzer 
For detailed instructions on instrument setup, spectral calibration, or application 
of the Applied Biosystems 3500 Series Data Collection Software version 1.0 and 
the GeneMapper ID-X Software version 1.2, refer to the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide.  

The system with 8 capillaries is the Applied Biosystems 3500 Genetic Analyzer 
and the system with 24 capillaries is the Applied Biosystems 3500xL Genetic 
Analyzer. 

The virtual filter set AnyDye is used for combined application of the 5 
fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is 
known as BT5.  

The materials required for electrophoresis are given in Table 35. 

Table 35. Materials required for electrophoresis 

Material Specifications 

Capillary 36 cm Array for Applied Biosystems 3500/3500xL 
Genetic Analyzer 

Polymer POP-4 for Applied Biosystems 3500/3500xL 
Genetic Analyzer 

Buffer Anode Buffer Container (ABC) 3500 Series 
Cathode Buffer Container (CBC) 3500 Series 

 

Spectral calibration/matrix generation 
Before conducting DNA fragment size analysis, it is necessary to perform a 
spectral calibration with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and 
BTO for each analyzer. The calibration procedure creates a matrix which is 
used to correct the overlapping of fluorescence emission spectra of the dyes.  

IMPORTANT: Spectral calibration must be performed for each new capillary 
array. 

Spectral calibration is comprised of the following steps: 

 Preparation of the instrument 

 Preparation of dye set BT5 

 Preparation of the standard calibration plate 

 Plate assembly and loading the plate in the instrument 
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 Performing a spectral calibration run  

 Checking the matrix 

Preparation of the instrument 

Before the spectral calibration process, ensure that the spatial calibration has 
been performed. This process is described in detail in the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide. 

Table 36. The fluorescent labels of BT5 

Color Matrix standard 

Blue (B) 6-FAM 

Green (G) BTG 

Yellow (Y) BTY 

Red (R) BTR 

Orange (O) BTO 
 

Software setup of dye set BT5 

Before the spectral calibration, a dye set for the Matrix Standard BT5 must be 
set up. 

1. To create a new dye set, go to “Library” and select “Analyze”, 
followed by “Dye Sets”, and click “Create”. 

2. Enter a “Dye Set Name”, e.g., BT5. 
3. Select “Matrix Standard” as a chemistry and “AnyDye Template” as a 

dye set template. 
4. Disable “Purple” in the field “Arrange Dyes”. Ensure that all other 

colors are enabled. 
5. Under “Calibration Peak Order” the colors need to be arranged as 

follows: 5 — blue, 4 — green, 3 — yellow, 2 — red, and 1 — orange. 
6. Do not change the “Parameter” settings. 
7. Click “Save” to confirm the changes. 
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Setup of dye set BT5. 

Preparation of the standard calibration plate 

Example for 8 capillaries (Applied Biosystems 3500 Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 37. 

Table 37. Setup of formamide and Matrix Standard BT5 mixture for 
8 capillaries 

Component Volume 

Hi-Di Formamide 90 μl 

Matrix Standard BT5 multi cap. 10 μl 
 

 
2. Load 10 μl of the mixture to a 96-well plate, e.g., positions A1–H1. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 
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Example for 24 capillaries (Applied Biosystems 3500xL Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 38. 

Table 38. Setup of formamide and Matrix Standard BT5 mixture for 
24 capillaries 

Component Volume 

Hi-Di Formamide 225 μl 

Matrix Standard BT5 multi cap. 25 μl 
 

 
2. Load 10 μl of the mixture to a 96-well plate, e.g., positions A1–H1, 

A2–H2, and A3–H3. When using a 384-well plate, load 10 μl of the 
mixtures to columns 1, 3, and 5 in rows A, C, E, G, I, K, M, and O. 

3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Plate assembly and loading the plate in the instrument 

The necessary steps are described in detail in the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide. 

Performing a spectral calibration run  

Once the multiwell plates containing the spectral calibration mixture are placed 
in the autosampler tray, the spectral calibration process can be started. 

1. To access the Spectral Calibration screen, select “Maintenance” on 
the Dashboard of the 3500 Series Data Collection software. 

2. The number of wells in the spectral calibration plate and their 
location in the instrument must be specified. 

3. Select “Matrix Standard” as a chemistry standard and “BT5” for dye 
set. 
(Optional) Enable “Allow Borrowing”. 

4. Click “Start Run”. 
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Checking the matrix 

1. Click a capillary in the table to display the results for each capillary 
(spectral data, quality value, and condition number) below the run 
results table.  

2. The quality value (Q value) of each capillary must be greater than 
0.8 and the number range (C value) must be between 1 and 20. 

3. Check the matrix samples for a flat baseline. As shown in the figure, 
there should be 5 peaks with peak heights of about 1000–5000 RFU 
for each matrix sample  
Note: The optimal range is 2000–4000 RFU. 

 

 

Electropherogram of spectral calibration with matrix standard BT5 on an Applied 
Biosystems 3500 Genetic Analyzer. 
 

4. If all capillaries have passed the calibration, the “Overall” row 
displays green results. If the “Overall” row displays red results, refer 
to the “Spectral Calibration Troubleshooting” section of the Applied 
Biosystems 3500/3500xL Genetic Analyzers User Guide. 

 

 
Example of a successful spectral calibration of the matrix standard BT5 for all 
capillaries on an Applied Biosystems 3500 Genetic Analyzer.  
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5. For each capillary, select and display the spectral and raw data. 
Check that the data meet the following criteria: 
The order of the peaks in the spectral profile from left to right read orange-
red-yellow-green-blue. 

No extraneous peaks appear in the raw data profile. 

Peak morphology in the spectral profile shows no gross overlaps, dips, or 
other irregularities. Separate and distinct peaks should be visible. 

6. If the data for all capillaries meet the criteria above, click “Accept 
Results”. If any capillary data does not meet the criteria above, click 
“Reject Results”, and refer to the “spectral calibration 
troubleshooting” section of the Applied Biosystems 3500/3500xL 
Genetic Analyzers User Guide. 

Sample preparation 
1. Set up a mixture of formamide and DNA size standard according to 

Table 39. 

Table 39. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12.0 μl 

DNA Size Standard 550 (BTO) 0.5 μl 
 

 
2. For each sample to be analyzed, aliquot 12 μl of the mixture to a 

tube. 
3. Add 1 μl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
5. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 
 

Since injections take place simultaneously on all capillaries, 8 or 24 samples 
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples 
are analyzed, the empty positions must be filled with 12 μl Hi-Di Formamide. 
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To ensure a reliable allelic assignment on multi-capillary analyzers, inject one 
allelic ladder for each set of 24 samples: 

 8-capillary instruments: One allelic ladder per 3 injections 

 24-capillary instruments: One allelic ladder per 1 injection  

Room temperature may influence the performance of PCR products on multi- 
capillary instruments, so that shoulder peaks or split peaks occur, especially at 
low temperatures. Ensure ambient conditions are kept, as recommended by the 
instrument manufacturer. 

Setting up a run 

If using the Investigator DIPplex Kit for the first time on an Applied Biosystems 
3500 Genetic Analyzer, you will first need to set up a number of protocols:  

 Instrument Protocol 

 Size Standard 

 QC Protocol 

 Assay 

All protocols can be set up via the Dashboard of the 3500 Series Data 
Collection software. 

1. To set up the Instrument Protocol, go to “Library” and select 
“Analyze”, followed by “Instrument Protocols”, and click “Create”. 
Note: Modify the Run Module Default settings from “HID36_POP4” as 
shown in Table 40. 

2. The parameters in Table 40 must be entered or selected. 
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Table 40. Instrument Protocol parameters for Applied Biosystems 
3500/3500xL Genetic Analyzer 

Parameter Setting 

Application Type HID 

Capillary Length 36 cm 

Polymer POP-4 

Dye Set e.g., BT5 

Run Module HID36_POP4 

Protocol Name e.g., Investigator DIPplex 

Oven Temperature (°C) Default 

Run Voltage (kV) Default  

Pre-Run Voltage (kV) Default 

Injection Voltage (kV) 3.0 

Run Time (s) 900 

Pre-Run Time (s) Default 

Injection Time (s)  8.0* 

Data Delay (s) Default 

Advanced Options Default 
 

* Deviating from the standard settings, the injection time may range between 1 and 20 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
of up to 20 s may be necessary. 

 

3. Click “Save” to confirm the changes. 
4. To set up the Size Standard, go to “Library”, select “Analyze”, 

followed by “Size Standards”, and click “Create”. 
5. The parameters in Table 41 must be entered or selected. 

The DNA Size Standard 550 (BTO) should be used with the following 
lengths of fragments: 60, 80, 90, 100, 120, 140, 160, 180, 200, 220, 
240, 250, and 260 bp. 



 

48 Investigator DIPplex Handbook   11/2014 

Table 41. Size standard parameters 

Parameter Setting 

Size Standard e.g., SST-BTO_60-260bp 

Dye Color Orange 
 

 
6. Click “Save” to confirm the changes. 
7. To set up the QC Protocol, go to “Library” and select “Analyze”, 

followed by “QC Protocols”, and click “Create”. 
8. The parameters in Table 42 must be entered or selected. 

Table 42. QC Protocol parameters 

Parameter Setting 

Protocol Name e.g., BTO_550 

Size Standard SST-BTO_60-260 (from Table 41) 

Sizecaller SizeCaller v1.1.0 
 

 

9. Go to “Analysis Settings”, followed by “Peak Amplitude Threshold” 
and disable “Purple”. Ensure that all other colors are enabled. 
All other settings should remain as “Default”. 

10. Click “Save” to confirm the changes. 
11. To set up an Assay, go to “Library” and select “Manage”, followed 

by “Assays”, and click “Create”. 
12. To analyze Investigator DIPplex fragments, the parameters in Table 43 

must be selected. 
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Table 43. Assay parameters 

Parameter Setting 

Assay Name e.g., Investigator DIPplex 

Color Default 

Application Type HID 

Instrument Protocol e.g., Investigator DIPplex (from Table 40) 

QC Protocols e.g., BTO_550 (from Table 42) 
 

 

13. Click “Save” to confirm the changes. 

Starting the run 

1. In the Dashboard, click “Create New Plate”.  
2. Go to “Define Plate Properties” and select “Plate Details”. Select or 

enter the parameters in Table 44. 

Table 44. Plate properties 

Property Setting 

Name e.g., Investigator DIPplex 

Number of Wells 96 

Plate Type HID 

Capillary Length 36 cm 

Polymer POP-4 
 

 

3. Click “Assign Plate Contents” to confirm the changes. 
4. Enter the designated sample name in each well containing a sample 

or allelic ladder. This will identify the well positions of each sample 
for the data collection and processing. 

5. Choose the correct Assay for the analysis. If you followed the steps 
under “Setting up a run” (page 46), this would be Investigator 
DIPplex from step 11. All named wells on the plate must have an 
assigned assay.  

6. Select the wells for which to specify an assay. Check the box next to 
the assay name to assign it to the selected wells.  
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7. (Optional) Repeat for file name conventions and results group. 
8. If not already done, load the instrument with the assembled plate 

and close the instrument door to re-initialize the instrument. Then 
click “Link Plate for Run”. In the next screen, enter the desired Run 
Name and click “Start Run”. 

 

Analysis parameters/analysis method 
Table 45 lists the recommended analysis parameters in the worksheet “Peak 
Detector”. Table 46 and Table 47 list the settings for the worksheet “Allele” and 
“Peak Quality”. 

Table 45. Recommended settings for the Applied Biosystems 
3500/3500xL Genetic Analyzer 

Parameter Settings 

Peak Detection Algorithm Advanced 

Ranges Analysis: Partial Range 

Start Point: 1000; Stop Point: 20,000 

Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  

Baseline Window: 51 pts 

Size Calling Method Local Southern Method 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:*   O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Slope Thresholds: 0.0 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be 
detected by the GeneMapper ID-X Software version 1.2. The thresholds are usually 50–200 RFU 
and should be determined individually by the laboratory. Recommendation: The minimal peak 
height should be 3 times higher than the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 
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Table 46. Recommended settings in the worksheet “Allele” 

Parameter Settings 

Amelogenin Cutoff 0.1* 
 

* As with Amelogenin, all DIPs will be examined using GeneMapper ID-X Software. 

Table 47. Recommended settings in the worksheet “Peak Quality” 

Parameter Settings 

Heterozygote Balance (Minimum peak height ratio) 0.1 

Allele Number (Maximum expected alleles) 20 
 

 
Note: For information on using the recommended Template Files (as analysis 
parameters), refer to the appropriate Investigator template files user guide 
(Genotyper, GeneMapper ID, or GeneMapper ID-X). 
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Protocol: Analysis 
For general instructions on automatic sample analysis, refer to the GeneScan, 
GeneMapper ID or GeneMapper ID-X Software User Guide.  

Finding the exact lengths of the amplified products depends on the device type, 
the conditions of electrophoresis, as well as the DNA size standard used. Due to 
the complexity of some loci, determining the size should be based on evenly 
distributed references. The DNA Size Standard 550 (BTO) should be used with 
the following lengths of fragments: 60, 80, 90, 100, 120, 140, 160, 180, 200, 
220, 240, 250, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 
500, 525, and 550 bp. 

 

 
Figure 1. Electropherogram of the DNA Size Standard 550 (BTO), fragments with 
lengths in bp. 

Analysis software 
Allele allocation should be carried out with suitable analysis software, e.g., 
GeneMapper ID-X, GeneMapper ID, or Genotyper Software in combination with 
the Investigator Template Files available as a download from www.qiagen.com, 
see Table 48 and Table 49. 

The recommended Investigator Template File for Genotyper Software is the 
DIPplex. 

In order to sort genotypes for easy interpretation of the results, QIAGEN offers 
DIPSorter Freeware. If using DIPSorter Freeware, use the recommended Table 
Settings for displaying and exporting the genotype table from GeneMapper ID 
(Table for 20 Alleles) or Genotyper software (Vertical Table for 20 Alleles). 
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Table 48. Recommended Investigator Template Files for GeneMapper ID  

File type File name 

Panels DIPplex_Panels 

BinSets DIPplex _Bins 

Size standard SST-BTO_60–260bp 

Analysis Method DIPplex_HID_310_50rfu 

DIPplex_HID_3130_50rfu 

DIPplex_HID_310_200rfu 

DIPplex_HID_3130_200rfu 

Plot Settings Plots_5dyes 

Table Settings Table for 20 alleles 
 

Panels and BinSets must always be used; other template files are optional. 

Table 49. Recommended Investigator Template Files for GeneMapper ID-X  

File type File name 

Panels DIPplex_Panels_x 

BinSets DIPplex_Bins_x 

Size standard SST-BTO_60–260bp 

Analysis Method DIPplex_HID_310_50rfu 

DIPplex_HID_3130_50rfu 

DIPplex_HID_310_200rfu 

DIPplex_HID_3130_200rfu 

DIPplex_HID_3500 

Plot Settings Plots_5dyes 

Table Settings Table for 20 alleles 
 

Panels and BinSets must always be used; other template files are optional. 
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Controls 
The alleles listed in Table 50 represent the Control DNA 9948 (included in the 
Investigator DIPplex Kit) and DNA from other commercially available standard 
cell lines. 

Table 50. Allele assignment of the Investigator DIPplex Kit 

Locus Control  
DNA 9948 

ATCC 
K-562 

CCR 
9947A 

CCR 
3657 

Amelogenin X/Y X X X/Y 

HLD77 + –/+ – + 

HLD45 + – –/+ –/+ 

HLD131 –/+ –/+ – + 

HLD70 –/+ –/+ + – 

HLD6 –/+ + + –/+ 

HLD111 –/+ + –/+ –/+ 

HLD58 + – + + 

HLD56 – – –/+ –/+ 

HLD118 – – – –/+ 

HLD92 + + –/+ – 

HLD93 – + – –/+ 

HLD99 + + –/+ –/+ 

HLD88 –/+ – – + 

HLD101 –/+ –/+ –/+ –/+ 

HLD67 + –/+ + + 

HLD83 – – –/+ – 

HLD114 + – – –/+ 

HLD48 –/+ + + + 

HLD124 + – –/+ + 
 

Table continued on next page. 
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Table continued from previous page. 

Locus Control  
DNA 9948 

ATCC 
K-562 

CCR 
9947A 

CCR 
3657 

HLD122 – – –/+ –/+ 

HLD125 + – –/+ – 

HLD64 –/+ – + –/+ 

HLD81 –/+ –/+ – + 

HLD136 + + –/+ –/+ 

HLD133 + – + –/+ 

HLD97 –/+ – –/+ + 

HLD40 –/+ + – + 

HLD128 – –/+ –/+ –/+ 

HLD39 + –/+ – – 

HLD84 –/+ + – – 
 

 

For further confirmation, the table above displays the alleles of the reference 
DNA purchased from Coriell Cell Repositories (CCR), as well as 3 reference 
DNAs purchased from CCR and ATCC up to the standard of Szibor et al. (2). 

Lengths of fragments and alleles 
Table 51 and Table 52 show the fragment lengths of individual alleles that refer 
to the DNA Size Standard 550 (BTO). Analyses were performed using an Applied 
Biosystems 3500 Genetic Analyzer (Figure 2) and an Applied Biosystems 3130 
Genetic Analyzer (Figure 3), both with POP-4 polymer. Different analysis 
instruments, DNA size standards, or polymers may result in different fragment 
lengths. In addition, a visual alignment with the allelic ladder is recommended. 

Scaling 

 Horizontal: 70–165 bp  

 Vertical: Depending on signal intensity 
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Table 51. Fragment lengths of the allelic ladder DIPplex analyzed on an 
ABI PRISM 3130 Genetic Analyzer (blue and green panels)  

Marker 
(blue) 

–DIP 
(bp)*  

+DIP 
(bp)* 

Marker 
(green) 

–DIP 
(bp)*  

+DIP 
(bp)* 

Amelogenin 77 (X) 80 (Y) HLD118 77 81 

HLD77 84 88 HLD92 87 90 

HLD45 92 96 HLD93 98 103 

HLD131 100 113 HLD99 108 113 

HLD70 104 108 HLD88 118 128 

HLD6 118 134 HLD101 131 135 

HLD111 122 126 HLD67 140 147 

HLD58 136 140    

HLD56 144 149    
 

* Rounded to integer. 

Table 52. Fragment lengths of allelic ladder DIPplex analyzed on an ABI 
PRISM 3130 Genetic Analyzer (yellow and red panels)  

Marker  
(yellow) 

–DIP 
(bp)*  

+DIP 
(bp)* 

Marker  
(red) 

–DIP 
(bp)*  

+DIP 
(bp)* 

HLD83 76 80 HLD136 79 84 

HLD114 83 100 HLD133 91 102 

HLD48 89 94 HLD97 97 110 

HLD124 104 109 HLD40 106 129 

HLD122 115 126 HLD128 113 121 

HLD125 129 135 HLD39 125 143 

HLD64 138 144 HLD84 135 140 

HLD81 147 158    
 

* Rounded to integer. 
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Figure 2. Electropherogram of the Investigator DIPplex Kit using 500 pg Control DNA 
9948. Analysis was performed on an Applied Biosystems 3500 Genetic Analyzer. Allele 
assignment was performed using GeneMapper ID-X  Software.
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Figure 3. Electropherogram of the allelic ladder DIPplex analyzed on an Applied 
Biosystems 3130 Genetic Analyzer. Allele assignment was performed using GeneMapper 
ID Software and the Investigator DIPplex Template File. 
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Interpretation of Results 
Post-PCR analysis and automatic allele assignment with suitable analysis 
software ensure a precise and reliable discrimination of alleles. 

General procedure for the analysis 

1. Check the DNA size standard. 
2. Check the allelic ladder. 
3. Check the positive control. 
4. Check the negative control. 
5. Analyze and interpret the sample data. 

Pull-up peaks 

Pull-up peaks may occur if peak heights are outside the linear detection range 
(see “Troubleshooting Guide”, page 60), or if an incorrect matrix was applied. 
They appear at positions of specific peaks in other color channels, typically with 
lower signal intensities. Peak heights should not exceed thresholds in order to 
prevent pull-up peaks.  

Template-independent addition of nucleotides 

Because of its terminal transferase activity, the Taq DNA polymerase may cause 
incomplete adenylation at the 3'-end of the amplified DNA fragments. The 
artifact peak is one base shorter than expected (–1 peaks). All primers included 
in the Investigator DIPplex Kit are designed to minimize these artifacts. Artifact 
formation is further reduced by the final extension step of the PCR protocol at 
68°C for 60 minutes. Peak height of the artifact correlates with the amount of 
DNA. Laboratories should define their own limits for analysis of the peaks. 

Artifacts  

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur. If shoulder or 
split peaks appear, we recommend injecting the sample again. 

Outside of the allelic range (>170 bp) amplification artifacts with very low 
signal intensity may occur. 
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Troubleshooting Guide 
This troubleshooting guide may be helpful in solving any problems that may 
arise. For more information, see also the Frequently Asked Questions page at 
our Technical Support Center: www.qiagen.com/FAQ/FAQList.aspx. The 
scientists in QIAGEN Technical Services are always happy to answer any 
questions you may have about either the information and protocols in this 
handbook or sample and assay technologies (for contact information, see back 
cover or visit www.qiagen.com).  

 Comments and suggestions 

Sample preparation 

Sample signal intensity 
must be increased 

Reduce the volume of the DNA Size Standard 
550 (BTO) to peak heights of about 500 RFU.  

Purify the PCR products before starting the 
analysis. We recommend the MinElute® PCR 
Purification Kit for rapid and effective purification 
(see Ordering Information). 

Matrix/spectral calibration is not appropriate 

 There are pull-up 
peaks between the dye 
panels (B, G, Y, R, O) 
with the current matrix/ 
spectral calibration 

This matrix cannot be used for the analysis. 
Repeat the matrix generation/spectral 
calibration. Be sure to carefully follow the correct 
protocol for the specific analysis instrument. 

Many peaks are labeled as off-ladder (OL) alleles in the samples 

a) DNA Size Standard 
550 (BTO) was not 
defined or identified 
correctly 

Click the orange “Size Match Editor“ icon in the 
upper toolbar or the GeneMapper ID or 
GeneMapper ID-X Software. Mark the orange 
fragments of all samples.  

Always use the DNA Size Standard 550 included 
in Investigator Human Identification PCR Kits. 
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 Comments and suggestions 

b) Signal intensities are 
too high. If the peak 
heights of the samples 
are outside the linear 
detection range 
(>4000 RFU/>5000 
RFU*), stutters, split 
peaks, and artifacts 
may be increased 

Reduce the injection time in increments to a 
minimum of 1 s, reduce the amount of the PCR 
amplification product for analysis, or reduce the 
quantity of DNA for PCR. 

c) Bubbles in the capillary 
lead to pull-up peaks 
in all color panels 
(“spikes”) that result in 
allele misnomer 

Repeat electrophoresis to confirm results. 

d) Differences in the run 
performance among 
the capillaries of a 
multi-capillary analyzer 
may result in allelic 
assignment shift 

For reliable allelic assignment on multi-capillary 
analyzers, a number of allelic ladders should be 
run. 

 

e) Use of 32-cycle PCR 
program for small 
amounts of DNA 

Too small amounts of DNA may result in allelic 
dropouts and imbalances of the peaks. 
Furthermore, nonspecific amplification products 
may appear. By increasing the number of cycles, 
there is a risk of cross-contamination due to 
impurities. 

Injection/file of the allelic ladder is not appropriate 

a) An additional signal 
can be identified as 
peak of the allelic 
ladder because of 
dysfunctions during the 
electrophoresis. If 
peaks of the allelic 
ladder are miscalled, 
the ladder cannot be 
used for the analysis 

Use a different injection/file of the allelic ladder 
and check the data of the analyzed sizes from 
the Size Standard (in bp) of the allelic ladder.  

Always use the DNA Size Standard 550 for 
Investigator Human Identification PCR Kits. 

 

 
* >4000 RFU for the ABI PRISM 310 Genetic Analyzer; >5000 RFU for the ABI PRISM 3100 

and Applied Biosystems 3130/3500 Genetic Analyzers. 
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 Comments and suggestions 

b) One peak of the allelic 
ladder is below the 
peak detection value 
(50–200 RFU) of the 
analysis method used, 
and thus, is not 
identified 

The allelic ladder must be loaded onto the 
analysis instrument at a higher concentration 
than samples to be analyzed.  

Alternatively, allelic ladder data can be analyzed 
with a lower peak detection value in Analysis 
Software. 

c) One peak of the allelic 
ladder is not identified 
because it is outside 
the expected size range 
of the software (in bp) 

Compare the length of the fragments (in bp) of 
the first allele in one color of the allelic ladder 
with the corresponding value in the categories. 
Then compare it with the other alleles. 

d) Point alleles are not 
found 

Point alleles are alleles with at least 1 bp 
difference to the next integer allele. Check the 
settings of the analysis method. Lower the Peak 
Window Size value to 11 points. 
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Ordering Information  
Product Contents Cat. no. 

Investigator DIPplex 
Kit (100) 

Primer mix, reaction mix, DNA Polymerase, 
Control DNA, allelic ladder, DNA size 
standard, and nuclease-free water 

384015 

Related products  

Investigator Quantification Kits  

Investigator 
Quantiplex Kit (200) 

Primer mix IC FQ, reaction mix FQ, 
control DNA Z1, dilution buffer 

387016 

Investigator 
Quantiplex HYres Kit 

Primer mix IC YQ, reaction mix YQ, 
control DNA Z1, dilution buffer 

387116 

Accessories  

DNA Size Standard 
550 (BTO) (100) 

DNA Size Standard 550 (BTO) for 100 
reactions 

386015 

Matrix Standard BT5 
single cap. (5 x 25) 

Matrix standard 6-FAM, BTG, BTY, BTR, 
and BTO 

386113 

Matrix Standard BT5 
multi cap. (25) 

Matrix standard 6-FAM, BTG, BTY, BTR, 
and BTO 

386123 

Matrix Standard BT5 
multi cap. (50) 

Matrix standard 6-FAM, BTG, BTY, BTR, 
and BTO 

386125 

Multi Taq2 DNA 
Polymerase (100) 

100 Units Multi Taq2 DNA Polymerase 386315 
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Product Contents Cat. no. 

DNA extraction and purification  

QIAamp® DNA 
Investigator Kit (50) 

50 QIAamp MinElute Columns, 
Proteinase K, Carrier RNA, Buffers, 
Collection Tubes (2 ml) 

56504 

EZ1® DNA 
Investigator Kit (48) 

Reagent Cartridges, Disposable Filter-
Tips, Disposable Tip-Holders, Sample 
Tubes (2 ml), Elution Tubes (1.5 ml), 
Buffer G2, Proteinase K, Carrier RNA 

952034 

MinElute PCR 
Purification Kit (50)* 

50 MinElute Spin Columns, Buffers, 
Collection Tubes (2 ml) 

28004 

 
For up-to-date licensing information and product-specific disclaimers, see the 
respective QIAGEN kit handbook or user manual. QIAGEN kit handbooks and 
user manuals are available at www.qiagen.com or can be requested from 
QIAGEN Technical Services or your local distributor. 

 
* Larger kit sizes available; please inquire. 
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Notes 

 



 

 

Trademarks: QIAGEN®, QIAamp®, EZ1®, Investigator®, MinElute®, Rotor-Gene® (QIAGEN Group); 3500™, 6-FAM™, ABI PRISM®, AmpFℓSTR®, 
Applied Biosystems®, Avant™, GeneAmp®, GeneMapper®, GeneScan®, Genotyper®, Hi-Di™, Minifiler™POP-4™, SEfiler Plus™ (Applera Corporation 
or its subsidiaries). Eppendorf®, Mastercycler® (Eppendorf AG); GenBank ® (US Department of Health and Human Services); Powerplex® (Promega 
Corporation). Registered names, trademarks, etc. used in this document, even when not specifically stated as such, are not to be considered 
unprotected by law. 

Notice to purchaser: Limited License 

Use of this product is covered by one or more of the following US patents and corresponding patent claims outside the US: 
5,789,224,5,618,711,6,127,155 and claims outside the US corresponding to expired US Patent No. 5,079,352. The purchase of this product 
includes a limited, non-transferable immunity from suit under the foregoing patent claims for using only this amount of product for the purchaser's 
own internal research. No right under any other patent claim, no right to perform any patented method, and no right to perform commercial 
services of any kind, including without limitation reporting the results of purchaser's activities for a fee or other commercial consideration, is 
conveyed expressly, by implication, or by estoppel. This product is for research use only. Diagnostic uses under Roche patents require a separate 
license from Roche. Further information on purchasing licenses may be obtained by contacting the Director of Licensing, Applied Biosystems, 850 
Lincoln Centre Drive, Foster City, California 94404, USA. 

Limited License Agreement for the Investigator DIPplex Kit 

Use of this product signifies the agreement of any purchaser or user of the product to the following terms: 

1. The product may be used solely in accordance with the protocols provided with the product and this handbook and for use with components 
contained in the kit only. QIAGEN grants no license under any of its intellectual property to use or incorporate the enclosed components of this 
kit with any components not included within this kit except as described in the protocols provided with the product, this handbook, and 
additional protocols available at www.qiagen.com. Some of these additional protocols have been provided by QIAGEN users for QIAGEN 
users. These protocols have not been thoroughly tested or optimized by QIAGEN. QIAGEN neither guarantees them nor warrants that they do 
not infringe the rights of third-parties.  

2. Other than expressly stated licenses, QIAGEN makes no warranty that this kit and/or its use(s) do not infringe the rights of third-parties. 

3. This kit and its components are licensed for one-time use and may not be reused, refurbished, or resold. 

4. QIAGEN specifically disclaims any other licenses, expressed or implied other than those expressly stated. 

5. The purchaser and user of the kit agree not to take or permit anyone else to take any steps that could lead to or facilitate any acts prohibited 
above. QIAGEN may enforce the prohibitions of this Limited License Agreement in any Court, and shall recover all its investigative and Court 
costs, including attorney fees, in any action to enforce this Limited License Agreement or any of its intellectual property rights relating to the kit 
and/or its components. 

For updated license terms, see www.qiagen.com. 

© 2011–2014 QIAGEN, all rights reserved. 
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